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1. To extends a selection to adjacent cells in MS word file which of the 
following shortcut key is used? 

(A) Hold right shift and press an arrow key repeatedly 

(B) Hold left shift and press an arrow key repeatedly 

(C) Hold up shift and press an arrow key repeatedly 

(D) Hold down shift and press an arrow key repeatedly 
 
2. To select a column in MS word file which of the following shortcut key is 
used? 
(A) Shift + up arrow 
(B) Shift + end 

(C) Use the arrow keys to move to the column's top or bottom cell, and then 
do one of the following 
(D) Shift + home 
 

3. To select the column from top to bottom in MS word file which of the 
following shortcut key is used? 
(A) Shift + alt + home 
(B) Shift + alt + page down 
(C) Shift + alt + page up 
(D) Shift + alt + end 
 
4. To select an entire row in MS word file which of the following shortcut key is 
used? 
(A) Alt + end 
(B) Shift + end 
(C) Home 

(D) Use arrow keys to move to end of the row, either the first cell (leftmost) 
in the row or to the last cell (rightmost) in the row 
 

5. To select the row from left to right MS word file which of the following 
shortcut key is used? 

(A) Shift+ alt+ end 

(B) Shift+ alt+ home 

(C) Shift+ alt+ left arrow 

(D) Shift+ alt+ right arrow 
 

6. To select the row from left to right MS word file which of the following 
shortcut key is used? 

(A) Shift+ alt+ end 
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(B) Shift+ alt+ home 

(C) Shift+ alt+ left arrow 

(D) Shift+ alt+ right arrow 
 
7. To extend a selection or block in MS word file which of the following 
shortcut key is used? 

(A) Ctrl+Shift+F5, and then use the arrow keys; press Esc to cancel 
selection mode 

(B) Ctrl+Shift+F8, and then use the arrow keys; press Esc to cancel 
selection mode 

(C) Ctrl+Shift+F7, and then use the arrow keys; press Esc to cancel 
selection mode 

(D) Ctrl+Shift+F1, and then use the arrow keys; press Esc to cancel 
selection mode 
 
8. To select an entire table in MS word file which of the following shortcut key 
is used? 

(A) Alt+6on the numeric keypad (with num Lock off) 
(B) Alt+2 on the numeric keypad (with num Lock off) 
(C) Alt+1 on the numeric keypad (with num Lock off) 
(D) Alt+5 on the numeric keypad (with num Lock off) 
 
9. To move the next cell in a row of table in MS word file which of the following 
shortcut key is used? 
(A) Tab key 
(B) Enter key 
(C) Left arrow key 
(D) End key 
 
10. To move the previous cell in a row of table in MS word file which of the 
following shortcut key is used? 
(A) Shift + left arrow 
(B) Shift + tab 
(C) Alt + home 
(D) Alt + tab 
 
11. To move the first cell in a row of the table in MS word file which of the 
following shortcut key is used? 
(A) Ctrl + home 
(B) Alt + home 
(C) Alt + end 
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(D) Home 
 
12. To move the first cell in a column of the table in MS word file which of the 
following shortcut key is used? 
(A) Page up 
(B) Alt + page up 
(C) Home 
(D) Alt + home 
 
13. To move the last cell in a column of the table in MS word file which of the 
following shortcut key is used? 
(A) Alt + page up 
(B) Alt + page down 
(C) Page down 
(D) End 
 
14. To move the previous row of a table in MS word file which of the following 
shortcut key is used? 
(A) Up arrow 
(B) Down arrow 
(C) Left arrow 
(D) Right arrow 
 
15. To move the next row of a table in MS word file which of the following 
shortcut key is used? 
(A) Left arrow 
(B) Up arrow 
(C) Down arrow 
(D) Right arrow 
 
16. To move row up of a table in MS word file which of the following shortcut 
key is used? 
(A) Alt + shift up arrow 
(B) Up arrow 
(C) Alt + up arrow 
(D) Ctrl + up arrow 
 
17. To move row down of a table in MS word file which of the following 
shortcut key is used? 
(A) Shift + down arrow 
(B) Down arrow 
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(C) Alt + down arrow 
(D) Alt + shift + down arrow 
 
18. To insert new paragraph in a cell in MS word file which of the following 
shortcut key is used? 
(A) Delete key 
(B) Tab key 
(C) Enter key 
(D) Insert key 
 
19 To insert tab characters in a cell in MS word file which of the following 
shortcut key is used? 
(A) Ctrl + tab 
(B) Alt + tab 
(C) Tab 
(D) Enter 
 
20. To open the font dialog box to change the formatting of characters in MS 
word file which of the following shortcut key is used? 
(A) Ctrl + D 
(B) Ctrl + V 
(C) Ctrl + B 
(D) Ctrl + C 
 
21. To change the case letters in MS word file which of the following shortcut 
key is used? 
(A) Shift + F7  
(B) Shift + F5 
(C) Shift + F3 
(D) Shift + F2 
 
22. To formatting all letters as capitals in MS word file which of the following 
shortcut key is used? 
(A) Ctrl + shift + F2 
(B) Alt + shift + F3 
(C) Ctrl + shift + F3 
(D) Ctrl + alt + F3 
 
23. To apply bold formatting in MS word file which of the following shortcut 
key is used? 
(A) Ctrl + I 
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(B) Ctrl + S 
(C) Ctrl + B 
(D) Ctrl + V 
 
24. To apply an underline in MS word file which of the following shortcut key is 
used? 
(A) Ctrl + K 
(B) Ctrl + S 
(C) Ctrl + U 
(D) Ctrl + B 
 
25. To underline words but not spaces in MS word file which of the following 
shortcut key is used? 
(A) Ctrl + shift + S 
(B) Ctrl + shift + P 
(C) Ctrl + shift + W 
(D) Ctrl + shift + X 
 
26. To apply double-underline text in MS word file which of the following 
shortcut key is used? 
(A) Ctrl + shift + D 
(B) Ctrl + shift + V 
(C) Ctrl + shift + B 
(D) Ctrl + shift + O 
 
27. To apply hidden text formatting in MS word file which of the following 
shortcut key is used? 
(A) Ctrl + shift + H 
(B) Ctrl + shift + K 
(C) Ctrl + shift + I 
(D) Ctrl + shift + P 
 
28. To apply italic formatting in MS word file which of the following shortcut 
key is used? 
(A) Ctrl + K  
(B) Ctrl + I 
(C) Ctrl + S 
(D) Ctrl + O 
 
29. To format letters as small capitals in MS word file which of the following 
shortcut key is used? 
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(A) Ctrl + shift + O 
(B) Ctrl + shift + K 
(C) Ctrl + shift + X 
(D) Ctrl + shift + C 
 
30. To apply subscript formatting (automatic spacing) in MS word file which of 
the following shortcut key is used? 
(A) Ctrl + hyphen sign (-) 
(B) Ctrl + underscore sign (_) 
(C) Ctrl + plus sign (+) 
(D) Ctrl + equal sign (=) 
 
31. How many different positions can you set for drop cap? 
(A) 1 
(B) 2 
(C) 3 
(D) 4 
 
32. How many ways you can save a document? 
(A) 3 
(B) 2 
(C) 4 
(D) 6 
 
33. What is the maximum number of lines can set for lines to drop box? 
(A) 5 
(B) 2 
(C) 10 
(D) 8 
 
34. Single spacing in MS-Word document causes______ point line spacing? 
(A) 10 
(B) 12 
(C) 15 
(D) 9 
 
35. What is the default number of lines to drop for drop cap? 
(A) 3 
(B) 6 
(C) 9 
(D) 12 
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36. What is the maximum number of lines you can set for a drop cap? 
(A) 9 
(B) 10 
(C) 15 
(D) 19 
 
37. How many columns can you insert in a word document in maximum? 
(A) 30 
(B) 45 
(C) 40 
(D) 41 
 
38. In a document what is the maximum number of columns that can be 
inserted in MS Word table? 
(A) 45 
(B) 50 
(C) 63 
(D) 60 
 
39. What is the maximum scale percentage available in scale drop down box? 
(A) 100 
(B) 200 
(C) 300 
(D) 50 
 
40. What is the maximum font size you can apply any character? 
(A) 163 
(B) 1638 
(C) 13602 
(D) 1500 
 
41. Word, by default, places a tab stop at every_________ mark o the ruler? 
(A) .25 
(B) .5 
(C) .10 
(D) .75 
 
42. What is the default file extension for all Word document? 
(A) .txts 
(B) .word 
(C) .doc 
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(D) .docx 
 
43. The file type________ indicates the file is a Word document? 
(A) .wor 
(B) .msw 
(C) .wrd 
(D) .doc 
 
44. With Word’s auto correct entries, to display an indifferent face (??) 
type___? 
(A) : ( 
(B) : ) 
(C) : | 
(D) : / 
 
45. Which of the following button will allow you to add, delete or change 
records in your data source? 
(A) ‘Data source’ button 
(B) ‘Edit’ button 
(C) ‘Edit data source’ button 
(D) ‘Data editing’ button 
 
46. How much space in minimum must be provided between columns? 
(A) 0” 
(B) 1” 
(C) 0.5” 
(D) 1.5” 
 
47. What is the smallest width of a column? 
(A) 0” 
(B) 0.5” 
(C) 1” 
(D) 1.5” 
 
48. By default, your document prints with? 
(A) 1 inch top and bottom margins 
(B) A portrait orientation 
(C) 1.25 inches left and right margins 
(D) All of the above 
 
49. Word is preset to use standard 8.5-by-11-inch paper with__ margins? 
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(A) 1-inch left, right, top, and bottom 
(B) 1.25 inch left, right, top, and bottom 
(C) 1.25 inch left and right margins and 1 inch top and bottom 
(D) 1 inch left and right margins and 1.25 inch top and bottom 
 
50. What is the default left margin in Word 2003 document? 
(A) 1” 
(B) 1.25” 
(C) 1.5” 
(D) 2” 
 
51. What is the smallest and largest font size available in font size tool on 
formatting toolbar? 
(A) 8 and 72 
(B) 11 and 60 
(C) 2 and 70 
(D) 5 and 75 
 
52. The footnote text style defines characters as? 
(A) 12-point Times New Roman and paragraphs as single-spaced and right-
aligned 
(B) 10-point Times New Roman and paragraphs as single-spaced and left-
aligned 
(C) 12-point Times New Roman and paragraphs as single-spaced and right-
aligned 
(D) 10-point Times New Roman and paragraphs as single-spaced and left-
aligned 
 
53. What is the default font size of a word document based on normal 
template in Word 2003? 
(A) 11 pt 
(B) 12 pt 
(C) 15 pt 
(D) 10 pt 
 
54. The minimum number of rows and columns in MS Word document is? 
(A) 1 and 1 
(B) 1 and 2 
(C) 2 and 2 
(D) All of the above 
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55. How will MS Word will respond in repeated word? 
(A) A red wavy line under the repeated word 
(B) A green wavy line under the repeated word 
(C) A blue wavy line under the repeated word 
(D) A black wavy line under the repeated word 
 
56. In mail merge operation which of the following might represent the main 
document? 
(A) A sales brochure 
(B) A form latter 
(C) A database of names and address 
(D) All of the above 
 
57. Pressing F8 key for three times select? 
(A) A word 
(B) A sentence 
(C) A paragraph 
(D) Entire document 
 
58. What do you call ‘a collection and paragraph formatting commands? 
(A) The defaults 
(B) A template 
(C) A style 
(D) A boilerplate 
 
59. What is a document outline view? 
(A) A preview in a fill screen 
(B) A preview with margins 
(C) A view with a margins and gutter 
(D) A view with a structure of heading at various levels 
 
60. Ctrl + z is used for? 
(A) Undo the last action 
(B) Redo the last action 
(C) Add the new page 
(D) Open the document 
 
61. The __________ in the resume wizard dialog box indicates the wizard is 
ready to create the document? 
(A) Start panel 
(B) Address panel 
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(C) Add/ sort heading panel 
(D) Finish panel 
 
62. What does ctrl += key effect? 
(A) Superscript 
(B) Subscript 
(C) All caps 
(D) Shadow 
 
63. The spike? 
(A) Allows you to combine text from several documents and then insert all the 
text into one document at on we time 
(B) Allows you to edit auto text entries 
(C) Allows you to format auto text entries 
(D) All of the above 
 
64. The word wrap creature? 
(A) Automatically move text to the next line when necessary 
(B) Appears at the bottom of the document 
(C) Allows you to type over text 
(D) This is the short horizontal line 
 
65. How can you make the selected character super scripted? 
(A) Ctrl + = 
(B) Ctrl + shift + = 
(C) Ctrl + shift 
(D) Alt + ctrl + shift 
 
66. When typing in a word field manually, what must you press to insert the 
code’s braces? 
(A) Ctrl + F6 
(B) Ctrl + F9 
(C) Alt + F1 
(D) Shift + F5 
 
67. What is the shortcut key to open the dialog box? 
(A) F12 
(B) Shift + F12 
(C) Alt + F12 
(D) Ctrl + F12 
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68. What is the shortcut key to split a table? 
(A) Alt + ctrl + shift 
(B) Ctrl + shift + enter 
(C) Alt + shift + enter 
(D) Alt + space + enter 
 
69. Which key is used to increase left indent? 
(A) Ctrl + I 
(B) Ctrl + M 
(C) F10 
(D) F7 
 
70. When the same word is used in multiple locations or a word is used that 
was not quite appropriate, a thesaurus can be used to look up a (n) _____ or 
a word similar in meaning? 
(A) Synonym 
(B) Homonym 
(C) Antonym 
(D) Metronym 
 
71. How many different documents you can open at one time? 
(A) Only one 
(B) No more than three 
(C) As many as your computer memory can hold 
(D) As many as your task bar can display 
 
72. Which of the following is the second step in creating a macro? 
(A) Start recording 
(B) Using your mouse or keyboard, perform the task you want to automate 
(C) Assign a keyboard shortcut to the macro 
(D) Give the macro a name 
 
73. When assigning a shortcut key to a symbol, you should always try to 
select a key or key combination that is? 
(A) Unassigned 
(B) Assigned to another task 
(C) Located on the ten key pad section of your keyboard 
(D) From the same font family as the symbol 
 
74. Which feature is used to replace straight quotes with smart quotes as you 
type? 
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(A) Auto correct as you type 
(B) Auto change as you type 
(C) Auto format as you type 
(D) Smart tags as you type 
 
75. Which of the following command is not available in tool menu? 
(A) Auto text 
(B) Auto correct 
(C) Auto summarize 
(D) Marco 
 
76. Word has a list of predefined typing, capitalization, and grammar errors 
that ________ can detect and correct? 
(A) Auto add 
(B) Auto correct 
(C) Auto spell 
(D) Auto entry 
 
77. If you want to convert a symbol or several lines of text into an AutoCorrect 
entry, you should? 
(A) Insert the symbol or type the text in a word document first. Then, select 
the text or symbol and go to the auto correct dialog box 
(B) Click the Tools menu and choose Auto Correct Options. Then, click the 
 Insert menu and choose Symbol (or click the Format menu and choose  
Paragraph) to add the symbol or paragraph to Auto Correct. 
(C) Auto Correct can only accommodate one line of text. It is not possible to 
convert a symbol or multiple lines of text into an Auto Correct entry. 
(D) Insert the symbol or type the text in a Word document first. Then, select 
the text or symbol and click the Edit menu followed by Paste Special. Select 
New Auto Correct Entry and then click OK 
 
78. Which option is not available in insert table auto for behavior? 
(A) Fixed column width 
(B) Auto fit to contents 
(C) Auto fit to window 
(D) Auto fit to column 
 
79. When you click on file menu in word 2010, it opens? 
(A) File menu 
(B) File commands 
(C) Backstage view 
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(D) File ribbon 
 
80. Tabs stop position cannot be the following alignment? 
(A) Decimal alignment 
(B) Center alignment 
(C) Bar alignment 
(D) Justify alignment 
 
81. Why the document you created at home displays with a different font at 
school? 
(A) Because you have a different printer at school than at home 
(B) Because you have a different monitor at school than at home 
(C) Because the font you used at home is not installed on school computer 
(D) Because the version of window is different 
 
82. Ctrl + B is used for? 
(A) Search the selected text 
(B) Paste the selected text 
(C) Bola the selected text 
(D) Open the specified file 
 
83. A master document contains__________, each of which contains a 
pointer to a file on a disk? 
(A) Placeholder 
(B) Sub document 
(C) Bookmark 
(D) References 
 
84. If the number of columns is selected 1 and the line between check box is 
marked, where is the line drawn? 
(A) In the left margin 
(B) In the right margin 
(C) Both the left and right margin 
(D) None of the above 
 
85. A feature of MS word that saves the document automatically after certain 
interval is available on? 
(A) Save tab on option dialog box 
(B) Save as dialog box 
(C) Both A and B 
(D) None of the above 
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86. After typing header text, how can you quickly enter footer text? 
(A) Press page down key and type the text footer 
(B) Click on switch between header and footer then type the text 
(C) Both A and B 
(D) None of the above 
 
87. To move the cursor page to page of document? 
(A) Ctrl + page down 
(B) Ctrl + page up 
(C) Both A and B 
(D) None of these 
 
88. You can jump to the next column by? 
(A) Clicking with your mouse on the next column 
(B) Press alt + down arrow 
(C) Both A and B 
(D) None of these 
 
89. Which of the following enables you to paste data multiple times? 
(A) Windows clipboard 
(B) Office clipboard 
(C) Both A and B 
(D) None of these 
 
90. You need to jump to the next column breaking current column right at rtge 
cursor position. How can you break column? 
(A) Pressing ctrl + enter 
(B) Pressing alt + shift + enter 
(C) Break command from insert menu 
(D) None of these 
 
91. In word you can force a page break? 
(A) By positioning your cursor at the appropriate place and pressing the F1 
key 
(B) By using the insert/selection break on the insert tab 
(C) By positioning your cursor at the appropriate place and pressing ctrl + 
enter  
(D) By changing the font size of your document 
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92. How can you increase the font size of selected text by one point every 
time? 
(A) By pressing ctrl + ] 
(B) By pressing ctrl + [ 
(C) By pressing ctrl + } 
(D) By pressing ctrl + { 
 
93. How to use format painter multiple times? 
(A) By click on lock format painter icon 
(B) By double click on the format painter icon 
(C) By selecting edit -> format painter -> multiple use 
(D) Format painter cannot be use multiple times 
 
94. What is the default font used in MS Word 2007 document? 
(A) Times new roman 
(B) Arial 
(C) Calibri 
(D) Preeti 
 
95. Word includes a series of predefined graphics called______ that can 
inserted into a Word document? 
(A) Clip art 
(B) Hyperlinks 
(C) Captions 
(D) Bookmarks 
 
96. A (n)_____ is a dot or other symbol positioned at the beginning of a 
paragraph? 
(A) Bullet 
(B) Logo 
(C) Cell 
(D) Target 
 
97. Which of the following is not a type of page margin? 
(A) Left 
(B) Right 
(C) Center 
(D) Top 
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98. Uppercase on change case dialog box and all caps on fonts dialog box 
both converts selected text into capital letters. What’s the difference between 
the two? 
(A) Both are same. They are only two different ways of capitalize text 
(B) It is faster to convert from change case than from font dialog box 
(C) Change case makes conversion permanent but all caps always be 
reverted 
(D) All caps on font dialog box makes the changes permanent where changes 
case can be always reverted 
 
99. Ctrl + A is used for? 
(A) Align right 
(B) Select all 
(C) Change font 
(D) Save document 
 
100. Which of the following is not on home ribbon? 
(A) Columns 
(B) Font color 
(C) Change style 
(D) Font 
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Answer 
 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

D C C D A B B D A B B B B A C 

16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 

A D C A A C C C C C A A B B D 

31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 

B A C B A B B C B B B D D C C 

46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 

A B D C B A D B A A A B C D A 

61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 

D B A A B B D B B A C D A C A 

76 77 78 79 80 81 82 83 84 85 86 87 88 89 90 

B A D C D C C B D A C C C C C 

91 92 93 94 95 96 97 98 99 100 
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C A B C A A C C B A 
      


